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Having a web site is a great way in which to provide 24/7 access to information, forms,
and documents for colleges/universities, departments, and organizations. Web sites are a
great resource for students since instructors can post a variety of information and study
aids including contact, schedule, and office hour information, additional explanation for
course material, interactive files/pages to help students to explore course concepts
further, and problem solutions as well as course documents and assignments.

As you begin the design considerations for your web site, it is helpful to explore the
Internet and to visit a variety of web sites both commercial and academic. Take note of
features that you like and those that you do not like, considering how information is
presented on web pages, the readability of text, background, and color combinations, the
use of graphics and hyperlinks, methods of navigation, and page length, among other
things. While appearance is important, readability, usability, and accessibility are more

important.

When creating a web site, it is important to consider the audience, the use of the site, the

information to be posted, the frequency of use and the frequency of update for the web

pages, the web browsers that may be used by those visiting the site, and the manner in
which information is organized and presented within the web site and on the pages
contained within the site.

e Audience: It is important not to assume that those visiting the site have a great deal
of experience in using computers and the World Wide Web in general. For example,
while many students have some experience in using computers, these experiences
may be limited to playing computer games, sending and reading email, and shopping.
Most students have limited experience in setting the Internet preferences for their web
browsers, changing the security level for files containing macros, or even for
selecting the home page for their web browser. Interest level and experience will
determine the extent to which students actually use and benefit from any web pages
that you create. Many students have limited or no experience in downloading and
printing pages from the WWW. Surprisingly, some do not seem to understand that
they use the same process to download a MS Excel or Maple file for class that they
do to download a movie or an MP3. Some have limited experience using and
detecting the presence of hyperlinks on web pages: some may not know that
hyperlinks can be attached to images, and unless there is some text to indicate the
presence of the hyperlink, they will not test images by moving the cursor over the
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image to watch for the cursor to change from an arrow to a pointed finger. In
addition, many may prefer to print pages rather than reading them on the screen.
Since for some pages, especially those for which you may want to include a variety of
exercises and mathematical notation, you may find it easier to use PDF files. This
presents an additional complication since there may be those who do not have Adobe
Acrobat Reader; including information about downloading Adobe Acrobat Reader as
well as a hyperlink to the download site essentially eliminates this problem.
Frequency of Use and Frequency of Update: When you publish your web site to
the World Wide Web, it is important to consider how frequently the site will be
accessed as well as the dependability of the server on which you post the web site. If
the server that you use is frequently down then you cannot expect visitors to be able
to access the materials that you post; students will use this as an excuse for getting
extensions on due dates. The availability of the server will also affect your ability to
update the web site. For example, I post my web site on two servers, one that is
easily accessible from my office computer (I have mapped a drive from my office
computer to the server so that I can simply copy and paste files into my server space)
and the other to which I can fip files that I want to post. Since the former is easy to
access and to update and the latter is more of a problem since ftp sessions are
frequently interrupted or timed out, I use the former as my main web site and,
reluctantly, the latter as a back up. Another consideration for frequency of update for
a web site is the external hyperlinks that you may use. Since you have no control
over hyperlinks to external web sites, you should frequently check these web sites for
changes and to see if these web sites still exist on the WWW. The author for the web
page may eliminate the page to which you have created a hyperlink or (s)he may
reorganize the web site so that accessing the page requires a different URL. In
addition to frequently checking external hyperlinks, you should consider contacting
the author of the web page to let him/her know that you have posted a hyperlink to
his/her page: the author will appreciate the hearing that someone is benefiting from
his/her work and (s)he may contact you in the event that (s)he changes the web page
or reorganizes the web site.

Frequently, web page designers do not fully consider the affects of page titles, font types
and colors, background colors and patterns, and images and sound as well as specialized
web page features and the web browser being used to display the page or the readability
and accessibility of information displayed on the page.

Page Titles: Page titles are displayed at the top of the web browser window and are
partially displayed in the Windows taskbar displayed at the bottom of the screen.
Page titles identify the web page to the user. In addition, Netscape uses the page title
as the name for bookmarks that you create; Microsoft Internet Explorer uses the page
title as the initial name for favorites that you set although you have the option to
change the name when you create a favorite.

Font Type: While specialized fonts like Bauhaus 93, Beesknees ITC, Blackadder
JTC, Brushscript MT, and Commercial Script BT may look interesting and seem
“fun”, they are difficult to read. Imagine having to read such text on the screen and
you will probably reconsider using such fonts; asking your friends and students about
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the readability of these fonts may completely change your mind about ever using
these fonts since the number of people who will be willing to read your web pages
will be limited. In addition, you cannot guarantee that the specialized fonts that you
may choose to use will be available on the computers on which your web pages will
be displayed. The most readable and most commonly available fonts are Times New
Roman and Arial. In general, Arial is a larger font than Times New Roman, and
when you compare these fonts using boldface type, for example, you will notice that
letters in Arial have equal thickness in comparison to Times New Roman. If you
choose not to specify the font for the page or for a section of a page then web
browser’s default font set by the user will be displayed in the browser window; for
Netscape, the default font is set using the Preference dialog box accessed using the
Preference entry on the Edit menu, and for MS Internet Explorer, the default font can
be set using the Fonts... button on the General tab of the Internet Options dialog box
that is accessed using the Internet Options entry on the Tools menu.

Font size: While the text size can be adjusted using the View menu for both
Netscape and MS Internet Explorer, it is helpful to those visiting your web pages if
you set an appropriate font size. In general, the best font sizes are 10 point, 12 point,
and 14 point. For some, 10 point type can be too small and 14 point type can be too
large. An additional consideration is the font that you are using. Since Arial is larger
than Times New Roman, 10 point Arial may be sufficient for your needs while 12
point Arial may be too large. Similarly, 10 point Times New Roman, by comparison, may
be too small overall while 12 point Times New Roman may be more appropriate. For
most, 14 point Times New Roman and 14 point Arial may be too large for
your needs. One may say that erring on the side of larger text is not a problem but it
can be irritating to the reader and it does make pages require more paper for those
who chose to print web pages rather than read them on the screen. Whether you use
Arial or Times New Roman, be careful of using font sizes smaller than 10 point and
larger than 14 point: 8 point Arial or 10 point Times New Roman type can be useful
for page locations given at the top of pages or navigation bars at the top, bottom, or
side of pages, and fonts larger than 14 point can be irritating to read on the screen or
on paper.

Background: Using background files, textures, patterns, and colors is a great way in
which to make artistic and appealing web pages. However, some background files
and patterns as well as the background and font type and color combination may
make text difficult to read on the page. If you choose a dark background with light
text, for example, a black background with yellow text, or a light background with
dark text, for example, a yellow background with blue text, these may be difficult or
harsh to view on the screen especially when the user’s eyes are tired. In addition, for
black and white or grayscale printing, the yellow text for the black background with
yellow text combination may be virtually impossible to read; for color printing, this
combination will produce difficult to read yellow text since the background is not
printed. In addition, you should consider the visually impaired and those who
experience color deficiencies. Lighthouse International, http:/www.lighthouse.org,
leading resource worldwide on vision impairment and vision rehabilitation, provides
information about effective use of color and color contrast on its page titled
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“Effective Color Contrast: Designing for People with Partial Sight and Color
Deficiencies”, http://www.lighthouse.org/color_contrast.htm. Using bright colors
may seem cheery but, in the long run, they will only irritate the eyes of those who
view the page for an extended period of time. In addition, if you pick font colors and
background colors with similar brightness and saturation then you can create a page
that is virtually invisible to some color-blind users, for example red on green or green
on purple — they may only be able to view these colors as a gray block. Check out the
example color combinations given on the Building Really Annoying Web Sites page
titled “Make Text and Background Colors Clash” at
http://www.molehillgroup.com/annoying/trick023.htm for effective illustrations of
difficult if not impossible to read text and background color combinations.

Page Length: While not always avoidable, long web pages can make it difficult for
users to access information. While creating one long web page on which you can
post all information can be easier to maintain and to update, multiple web pages on
which related information is grouped is more helpful and less frustrating for users.
Pages on which related information is grouped allows users to quickly access
information. If you must use long web pages then use bookmarks/anchors to allow
users to navigate to desired information quickly.

Images and Sound: Using images and sound files may seem like a nice way in
which to dress up a web page but the presence of images and sound files increase the
download time for pages to display in web browsers. Sound files that play
automatically when the page is displayed in the browser window can be annoying to
users and may seem immature rather than professional to those visiting the page. If
you must include a sound file, consider giving the user the option fo furn on the sound
rather than having to turn off or mute the speakers every time (s)he visits your web
site. Those using text-only web browsers, screen readers, or those who have selected
not to display images, will have no information about the purpose, decorative or
hyperlink, of images on your web pages unless you include alternate text; one can
select not to display images using the Advanced tab in the Internet Options dialog box
that can be accessed using the Internet Options entry on the Tool menu of MS
Internet Explorer or using Internet Options on the Control Panel. Alternate text,
displayed when the user moves the cursor over an image or when the image cannot be
displayed, can be used to inform users of the presence of hyperlinks and to describe
the image to those who cannot see the image. When alternate text is not available, no
text explanation is given, and the image cannot be seen, there is no way for the user to
determine the importance of the missing image; it is unrealistic and unfair to assume
that the user will left-click (or the equivalent) on all images that you include on your
web pages in order to determine if there are hyperlinks attached to these images. In
addition, those visiting your pages may be unfamiliar with the use of hyperlinks on
images unless you provide information how to access these hyperlinks; both text
directions as well as alternate text makes the hyperlink accessible to all users.

Special Features: If you choose to add special features like hover buttons or a
scrolling marquee to your web pages, it is important to know how these will work, if
at all, in various web browsers. For example, hover buttons are “activated” when the
user moves the cursor over the button, and hover buttons provide no information
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about the presence of hyperlinks for inexperienced users. In addition, the color
combinations that you choose and the flash activity that you select for the rollover
effect may not be perceptible for all users: the color combination may cause the
button to be virtually invisible to those who are color-blind or the color change may
be imperceptible to those with vision impairments. If you choose to use hover
buttons, it is important to provide information about their presence and their use as
well as to choose appropriate color combinations. The basic scrolling marquee only
works with MS Internet Explorer; the text for the scrolling marquee will be displayed
on the page using your chosen formatting when the page is displayed using Netscape.
You can write JavaScript code that will display a scrolling marquee in the Netscape

browser window.

There are many points to consider in designing web pages that are truly accessible to all
users. First, you may find it helpful to visit the World Wide Web Consortium web site,
http://www.w3c.org, and to read about the Web Accessibility Initiative (WAI),
http://www.w3.org/ WAL/, to read about alternate web browsers,
http://www.w3.org/WAI/References/Browsing, and to consider how web pages that you
are creating, pages that you have created, or web pages that you frequently use are
viewed in a text-only format using the Lynx Viewer that can be accessed at
http://www.delorie.com/web/lynxview.html. In addition, you will find it helpful to read
the Web  Content  Accessibility  Guidelines,  http:/www.w3.org/TR/WAI-
WEBCONTENT/wai-pageauth.html, and the List of Checkpoints for Web Content
Accessibility Guidelines, http://www.w3.0org/TR/WAI-WEBCONTENT/checkpoint-
list.html. In these documents, you will find helpful information about web page design
features that may make accessing and using web pages difficult for those who use
alternate web browsers, information that will help you to effectively use tables to
organize information on web pages, and guidance on using images and effective
navigation. In general, these resources will give you a great deal to consider in regard to
web page design, the problems than many experience in using documents posted on the
web, and guidance on how to increase the accessibility and usefulness of pages that you

design.

You have many options regarding software that you can use to design web pages, MS
FrontPage and Macromedia Dreamweaver if you want to be able to edit the HTML code
as well as use the program features, text editing software with which you may be familiar
such as MS Word and Corel WordPerfect, or you could learn basic HTML. Whatever
you choose to use, carefully consider the features that you include on your web pages.
Before you begin designing your web page, try creating a page that contains a variety of
font sizes and font types using the background colors or files as well as the font colors
that you may have chosen. This will help you to test the readability of the your font,
color, and background selection before you invest time creating the actual web pages; ask
friends and students for feedback on the readability of the test page(s). Overall,
remember to consider the audience for your web site and how the features that you
include can enhance and limit the accessibility of the web pages that you create. Have
fun and be creative but most important of all, think of those who will use your web site.
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